
مقدمه
همانطور که می‏دانیم مبحث رسم نمودار ترکیبی است از فن گرافیک، فرمول‏نویسی و سایر تکنیک‏های 

کاربردی که می‏تواند هدف و خواسته‏ی شما را به تصویر بکشد. 
قس��مت عمده و بسیار مهم و تاثیرگذار رس��م نمودار مبحث گرافیک آن می‏باشد، اما به جهت شباهت 
بس��یار زیاد آن با مبحث گرافیک اش��یا در اکس��ل، از توضیح مکررات اجتناب می‏کنی��م و مرور آن را به 
خواننده واگذار می‏کنیم. تنها به بیان برخی نکات می‏پردازیم. اس��تفاده از گرافیک در این قس��مت، کاملا 
بس��تگی به ذوق و سلیقه شما دارد و می‏تواند بسیار جذاب و تاثیرگذار باشد. ما در این فصل سعی کردیم 
از بین مباحث مختلف و گس��ترده این موضوع، به معرفی انواع نمودار و کاربرد آن‏ها، و بیان نکات بس��یار 

کاربردی و فرمول‏نویسی، جهت رسم نمودارهای تخصصی و پویا بپردازیم.
گفتنی اس��ت که مبحث نمودار بس��یار گسترده می‏باش��د و این فصل تنها بخش کوچکی از این مهم را 

در بر می‏گیرد. 

نمودار
بیش‏ترین کاربرد اکسل بعد از امکانات محاسباتی و گرافیک، استفاده از امکانات نمودار در اکسل است. 

دلیل ارجحیت ترسیم نمودار نسبت به ترسیم جداول اطلاعاتی این می‏باشد: 
نمودارها داده‏ها را می‏توانند خلاصه نمایند. 

نمودارها بهترین حالت مقایسه اطلاعات می‏باشند. 
سرعت نتیجه‏گیری گرافیکی انسان از سرعت نتیجه‏گیری عددی بسیار بالاتر است. 

با دقت در گزارش‏های مختلف متوجه می‏ش��ویم که اگر در این گزارشات نموداری ترسیم شده است با 
احتمال زیاد این نمودارها در اکسل طراحی گردیده‏اند. 

دو نمونه از مشکلاتی که در زمینه کار با نمودارها وجود دارد این است که بدون شناخت از ویژگی‏های 
داده‏ها و نوع نمودارها اقدام به ترس��یم نمودار می‏نماییم. این کار ممکن اس��ت برداش��ت بیننده را دچار 
اشکال نماید. زیرا به عنوان مثال نمودار ستونی برای نمایش فراوانی بکار می‏رود و استفاده از نمودار خطی 
در این حالت اش��تباه می‏باشد. از این جهت اس��ت که در در هنگام کشیدن نمودار باید مطالعه دقیقی در 

زمینه ترسیم نمودارها داشته باشید.
مورد دوم اینکه، افرادی که با اکس��ل کار می‏کنند مباحثی مثل فرمول‏نویس��ی یا تحلیل داده‏ها یا تهیه 
گزارش را یک کار تخصصی می‏دانند و مباحثی مثل نمودار را یک کار عمومی مثل تایپ کردن می‏شمارند. 

در حالیکه این مبحث خیلی پیشرفته و مهم است که تسلط بر آن نیازمند صرف زمان زیادی می‏باشد.
 اگر ما محدوده‏ای از اطلاعات را برای رس��م نمودار انتخاب نماییم،  با زدن کلید F11 نمودار مربوط به 
این اطلاعات در یک صفحه چارت تشکیل می‏شود. )نموداری که از این طریق رسم می‏شود از نوع ستونی 

می‏باشد.(
برای ترسیم نمودار در کاربرگ اطلاعات می‏توان از کلید میانبر Alt+F1 استفاده نمود. 

نکته: در صورتی که ما فقط یک س��تون داده را انتخاب نماییم به جای اطلاعات محور X اعداد را از 1 
به طور اتومات در محور X قرار می‏دهد.

ب��ا انتخاب یک نم��ودار 3 منوی جدید در بالای صفحه ایجاد می‏گردند که تمامی تنظیمات نمودارها را 
از این قسمت می‏توان انجام داد. 
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برای ترس��یم یک جدول بر طبق خواس��ته ما بهترین راه اس��تفاده از ویزارد مرحله به مرحله در اکسل 
می‏باش��د ول��ی قبل از این توضیح یادآوری یک نکته ضروری اس��ت و آن هم تف��اوت مفهوم دو نوع داده 

پیوسته و گسسته می‏باشد.
داده گسس�ته: داده‏هایی که در بین هر یک از دو آیتم آن‏ها هیچ آیتم دیگری )ارزش دیگری( وجود 

ندارد.
مثلا یک آیتم به نام شهرس��تان تهران و یک آیتم دیگر به نام شهرس��تان مشهد وجود دارد و هر کدام 
از آن‏ه��ا یک جمعیتی دارند. ولی در بین مش��هد و تهران هیچ ارزش ع��ددی وجود ندارد و در این حالت 

نمی‏توان از نمودار خطی استفاده نمود.
داده‏های پیوس�ته: داده‏هایی ک��ه در میان تمام نقاط آن اطلاعات و ارزش��ی وجود دارد. فرض کنید 
که محور Xها اطلاعات س��اعات یک روز و محورY درجه حرارت باش��د، ساعت 10 دمای هوا 18 درجه و 
ساعت 12 درجه حرارت برابر 22 درجه است. می‏توان نتیجه گرفت که دما در ساعت 11 برابر 20 درجه 

می‏باشد این اطلاعات را می‏توان به صورت خطی فرض نمود.
برای ترس��یم نمودارها باید ابتدا انواع نمودار را معرفی نمود س��پس بدانیم برای هر نوع داده‏ای چه نوع 

نموداری را باید ترسیم نمود: 
برای دیدن انواع دسته نمودارها از مسیر: 

Insert> Charts> Other Charts> All Charts Type
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Column: نمودار ستونی، این نمودار برای ترسیم فراوانی داده‏ها به کار می‏رود و این نمودار را می‏توان 
جزو پرکاربردترین نمودارها به شما آورد. 

Line: نمودار خطی–این نمودار برای ترسیم داده‏های پیوسته بکار می‏رود. 
Pie: نمودار دایره‏ای–از این نمودار برای بررسی نسبت‏ها و سهم استفاده می‏شود.

Bar: نمودار میله‏ای–برای ترس��یم مقادیر یک س��ری داده‏ای یا فراوانی آن‏ها استفاده می‏گردد. تفاوت 
آن با نمودار س��تونی در این اس��ت که ساختار مغز انسان به گونه‏ای است در نمودار میله‏ای که ارزش‏ها به 
صورت افقی ترسیم می‏گردد بهتر می‏تواند میله‏ها را با هم مقایسه نماید و آن‏ها را نسبت به هم بسنجد. 
Area: نمودار س��طحی-این نمودار همانند نمودار خطی اس��ت با این تفاوت که س��طح زیر نمودار نیز 

معنی‏دار می‏باشد. مانند مقادیر یک انتگرال 
X Y (Scatter): نمودار پراکندگی-این نمودار که مربوط به مباحث ریاضی رگرسیون می‏باشد. یکی از 
امکانات جالب این نمودار این می‏باش��د که بعد از ترس��یم این نمودار با تنظیمات اندکی می‏توان تابع این 

نمودارها را ترسیم نمود.
Stock: این نمودار برای ترس��یم داده‏هایی استفاده می‏ش��ود که نیاز است سطوح اطمینانی برای آن‏ها 
ترس��یم نم��ود. در فعالیت‏هایی همچون مباحث کنترل کیفیت و یا مباح��ث تلرانس، که دارای حد بالا و 
پایین می‏باش��د می‏توان از این نمودارها س��تفاده نمود در این نمودار بر خلاف نمودارهای بالا یک س��تون 

داده عددی کفایت نمی‏کند.
Surface: نمودار 3 بعدی– این نمودار که برای ترس��یم داده‏ها به صورت 3 بعدی اس��تفاده می‏ش��ود 
با اس��تفاده از داده‏های اولیه‏ای به صورت ماتریس��ی قابل انجام خواهد بود. در واقع کاربرد این نمودار را 

می‏توان برای ترسیم مباحث ترمودینامیک و مقاومت مصالح دانست. 
Douhgnut: نمودار دونات–این نمودار شباهت زیادی به نمودار دایره‏ای دارد ولی کاربرد خاصی که این 

نمودار دارد این است که برای ترسیم چند سری داده‏ای نیز می‏توان از این نمودار استفاده نمود. 
Buble: نمودار حبابی–این نمودار برای بررس��ی و تحلیل مس��ائل مهندس��ی مالی و نمونه‏های از بازار 

بورس کاربرد دارد. 
Radar: نمودار رادار-کاربرد این نمودار برای زمانی است که میزان هم‏پوشانی چند گروه را می‏خواهیم 

بس��نجیم. به عنوان مثال فرض نمایید می‏خواهید میزان فروش 3 ماه 
)فروردین، اردیبهشت، خرداد (در 4 سال متوالی 90 تا 94 با همدیگر 
مقایس��ه نمایی��م در واقع بهترین و کامل‏ترین ابزار برای ترس��یم این 

داده‏ها نمودار رادار می‏باشد. 
برای ترسیم نمودارها بهترین روش استفاده از انجام ویزارد مراحل 

می‏باشد برای انجام این کار مراحل زیر را باید انجام دهید. 
ف��رض کنید برای جدول��ی مانند ش��کل 2-16 می‏خواهید نمودار 

ترسیم نمایید.

شکل16-2
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در ابتدا س��تون ماه و فروش را انتخاب می‏کنیم س��پس نوع نمودار مورد نظر را از مس��یر زیر انتخاب 
می‏کنیم:

Tab Insert > Charts > …
نوع نمودار میله‏ای را انتخاب می‏کنیم.

برای افزودن س��تون جدید به این نمودار بایس��تی بر روی نمودار راست کلیک کرده و Select Data را 
انتخاب نماییم. با زدن کلید Add کادر زیر )ش��کل3-16( نمایان می‏ش��ود که می‏توانیم یک ستون جدید 

را به این نمودارها اضافه کنیم.

فرض کنید قصد داریم ستون جدید به نام میزان سود را به این ستون‏ها اضافه نماییم بعد از زدن کلید 
Add در قس��متName آدرس سلول C2 که کلمه س��ود نوشته شده و در قسمت Value آدرس محدوده 

C2:C7 را وارد می‏کنیم. پس از زدن ok نمودار زیر نمایش داده می‏شود.

شکل16-3
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چنانچ��ه بخواهی��د تعیین کنیم که نمودار در یک صفحه چارت ظاهر ش��ود یا به صورت یک ش��ی در 
یک صفحه، باید بر روی نمودار راس��ت کلیک کنید و Move Chart را انتخاب نماییم. اگر New Sheet را 
انتخاب کنیم در یک کاربرگ جدید وارد می‏ش��ود و در صورت انتخاب Object In در داخل هر کاربرگی 

که در فروریز جلوی آن تعیین نمایید، قرار می‏گیرد.

تنظیمات گرافیکی نمودار: 
تمام تنظیماتی که بر روی یک ش��ی قابل انجام می‏باش��د مثل تنظیمات مربوط به فونت و رنگ فونت، 
 Tab پس زمینه و .... تقریبا در نمودار هم قابل انجام می‏باش��د. کافی اس��ت بر روی نمودار کلیک نمایید تا
Chart Tools ظاهر ش��ود و از روی س��ه منوی Format ,Design ,layout تنظیمات مورد نظر را بر روی 
نمودار اعمال نمایید. یا با کلیک راس��ت بر روی نم��ودار و انتخاب Format Chart Area تنظیمات مربوط 
به گرافیک نمودارها را می‏توان انجام داد. نکته لازم به ذکر این اس��ت که ممکن اس��ت برخی از نمودارها 
تنظیماتی را داشته باشند که نمودارهای دیگر نداشته باشند. بنابراین برای تنظیمات ما عمومی‏ترین حالت 

نمودار یعنی نمودار ستونی را در نظر می‏گیریم. 
ب��ا کلیک راس��ت بر روی میله یک نم��ودار و انتخاب گزین��ه Format Data Series از تب Fill می‏توان 

تنظیمات مربوط به رنگ و پس‏زمینه یک نمودار را انجام داد‏. 
 Clipart در صورتی که بخواهید می‏توانید پس‏زمینه یک نمودار را یک عکس نیز قرار دهید و استفاده از
نی��ز می‏توان��د باعث زیبایی نمودار گردید. برای این کار باید یک Clipart را در صفحه اکس��ل ایجاد نمود. 
سپس با کلید میانبر Ctrl+C آن را کپی و سپس بعد از انتخاب میله نمودار با کلید میانبر Ctrl+V تصویر

Clipart به جای نمودار قرار می‏گیرد.

 
شکل16-5
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در صورتی که بخواهیم تنظیماتی از جمله قرار دادن اعداد بر روی میله‏ها یا ترس��یم جدول داده‏ها در 
زیر نمودار را انجام دهیم نمودار را انتخاب و از منوی Layout این تنظیمات را انجام دهیم. 

Chart Titles: ب��رای نمایش عنوان چارت یا حذف عنوان چارت می‏توان از این گزینه اس��تفاده نمود. 
در واقع باید عنوان چارت را بصورت دس��تی ویرایش نمود علاوه بر این می‏توان باکس مربوط به عنوان را 
 Enter انتخاب و در نوار فرمول آدرس س��لولی را که عنوان در آنجا نوش��ته شده است را تایپ نمود سپس

زد. در این حالت هر اطلاعاتی که در سلول نوشته شود در عنوان چارت نمایش داده می‏شود. 
ف��رض کنید 2 نمودار س��ود و فروش را جداگانه می‏خواهیم مش��اهده کنیم )با رس��م یک نمودار(، به 
اینصورت که از یک لیس��ت فروریز، با انتخاب نمودار س��ود نمایش داده ش��ود و با انتخاب فروش نمودار 
فروش. درانتهای فصل به توضیح چگونگی رس��م این ن��وع نمودارهای پویا می‏پردازیم. اما چگونه می‏توان 
عنوان نمودار را نیز پویا کرد که با انتخاب سود و فروش، علاوه بر نمایش اطلاعات مورد نظر، عنوان نمودار 

نیز به سود و فروش تغییر کند؟
برای این کار از ترفند بالا استفاده می‏کنیم. به اینصورت که ابتدا از طریق کمبوباکس، لیست مورد نظر 
 )choose یا vlookup( با فرمول B1 باشد و در سلول A1 سلول Cell Link را ایجاد می‏کنیم. فرض کنید
 Chart تعیین می‏کنیم که کدام مورد انتخاب ش��ده، س��ود یا فروش. حالا پس از رسم نمودار، روی باکس
Title کلیک می‏کنیم. در نوار فرمول علامت = را قرار می‏دهیم و روی سل B1 کلیک می‏کنیم. برای اینکه 
عبارت میزان را هم در کنار س��ود و فروش داش��ته باش��یم، در س��لول B1 کلمه میزان را به فرمول عطف 

می‏کنیم:
 )"فروش";"سود" ;Choose )A1&"میزان"=

حال با انتخاب هر مورد از لیست کمبوباکس، عنوان نمودار به همان نام تغییر می‏کند.
Axis Titles: محل نمایش عنوان محور افقی و عمودی را مشخص می‏نماید.

 Format گزینه Y را تغییر بدهیم باید با کلیک راس��ت بر روی محو Y اگر بخواهیم مقیاس‏های محور
 Auto را انتخ��اب نم��ود و تنظیمات لازم را در تب‏های مرتب��ط انجام داد. در حالت پیش‏فرض روی Axis
می‏باشد. با انتخاب گزینه Fixed می‏توان کمترین، بیشترین و حداقل و حد اکثر فاصله بین اعداد را تعیین 
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نمود. کادری شبیه شکل 6-16 زیر ظاهر می‏شود.
گزینه Value In Reverse Order باعث می‏ش��ود محورy از بالا به پایین رس��م شود. به شکل فوق توجه 

کنید.
Legend: راهنمای عنوان سری‏هایی که داده‏های آن در یک نمودار ترسیم شده است. 

Data Labels: برای نمایش ارزش‏های عددی و یا عنوان نمودارها بر روی هر میله می‏توان از این گزینه 
تنظیم��ات م��ورد نظر را اعمال نم��ود. در حالت پیش‏فرض با انجام این تنظی��م ارزش‏های عددی بر روی 
میله‏ها نمایش داده می‏شود. برای این که عنوان سری‏ها یا عنوان محور افقی بر روی میله‏ها نمایش داده 
ش��ود باید بر روی اعداد روی میله کلیک راست نمود سپس گزینه Farmat Data Labels را انتخاب نمود 

و در تب Label Options تنظیم نمایید چه داده‏ای نمایش داده شود. 
Data Tables: جهت نمایش ایجاد جدول داده‏های که نمودار آن ترسیم شده است در زیر محور افقی 

نمودار، از این گزینه استفاده می‏نماییم. 

انتقال فرمت نمودارها:
اگ��ر برای یک چارت فرمت خاصی را تعبی��ه نموده‏ایم و می‏خواهیم روی نمودارهای دیگر اعمال کنیم. 
برای اینکار چارت مورد نظر را کپی نمود و س��پس نمودار جدید را انتخاب نمایید و از مس��یر زیر فرمت را 

انتقال دهید:
Tab Home> Clipboard> Paste> Paste Special> Formats

 یک راه دیگر برای اینکار وجود دارد. این روش فرمت مورد نظر را برای همیش��ه در حافظه اکس��ل نگه 
م��ی‏دارد و ت��ا زمانی که آفیس خ��ود را حذف نکنید باقی خواهد ماند. جهت اس��تفاده از این امکان، ابتدا 

نمودار مورد نظر خود را انتخاب نموده و به مسیر زیر می‏رویم:
Chart Tools> Design> Save As Template

نام دلخواه برای این نمودار انتخاب می‏کنیم و گزینه save را می‏زنیم.
هر زمان نیاز داشتیم فرمت این نمودار را به نمودارهای دیگر نیز انتقال دهیم، نمودار مورد نظر که می 

خواهیم فرمت ذخیره شده را بر روی آن اعمال نماییم، انتخاب می کنیم. به مسیر زیر می رویم:
Chart Tools> Design> Change Chart Type> Templates

فرمت ذخیره شده مورد نظر را انتخاب می‏کنیم و Ok را می‏زنیم.
گاهی ما نیاز داریم برای مقایس��ه بهتر اطلاعات س��تون‏های اطلاعاتی را در دل یکدیگر قرار دهیم، باید 

از مسیر زیر این کار را انجام دهیم:
1. انتخاب یک دسته از میله‏های روی چارت 

Format Data Series 2. کلیک راست و انتخاب
3. در تب Series Options گزینه Secondary Axis را انتخاب نماییم.

4. در ت��ب Option ب��رای Overlap مقدار صف��ر و برای Gap Width مقداری کمتر از آنچه می‏باش��د، 
انتخاب می‏کنیم. )شکل16-7(

در این حالت ممکن اس��ت دو محور چپ و راس��ت y، عدد بگیرد که باید واحد و مقیاس هر دو محور را 
به یک مقدار برسانیم در غیر اینصورت خروجی ما اشتباه می‏باشد. برای تنظیم دو نمودار با یک مقیاس بر 
روی یکی از محورهای عمودی اعداد کلیک راست نموده و گزینه Formataxis را انتخاب می‏کنیم سپس 
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از Axis Options تنظیمات شروع و پایان و فاصله بین اعداد را مشخص می‏نماییم. 

ترسیم نمودارهای پیشرفته در چند مسئله خاص:
1. اگر می‏خواهید مباحث رگرس��یون این مقادیر را دنبال کنید نمودار را از نوع خطی Scatter انتخاب 

نمایید. سپس بر روی خط آن کلیک راست نمایید، گزینه Add Trendline را انتخاب کنید.
از فرم بوجود آمده در تب Type نوع نمودار بوجود آمده را انتخاب می‏کنیم و در تب Option دو گزینه 

آخر را تیک می‏زنیم که برای نشان دادن R وخود تابع بر روی نمودار می‏باشد.
2. اگر قرار اس��ت در نموداری چند دسته داده با مقیاس‏های حجمی متفاوت ولی با شراط زیرمجموعه 

بودن یکدیگر را نمایش دهید می‏توانید با نوعی از نمودارPie این کار را انجام دهید. 

فرض کنید می‏خواهید میزان فروش در 2 ماه فروردین و اردیبهش��ت و خرداد را بصورت ریز )4 هفته 

شکل16-7

شکل16-8
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خرداد( نمایش دهید 
برای ترس��یم ای��ن نمودار باید از زیرمجموعه نمودار Pie نم��ودار Pie Of Pie یا Bar Of Pie را انتخاب 

نمایید. 
داده‏ها را باید مانند ش��کل 8-16 وارد نمایید. توجه کنید برای ماه خرداد که می‏خواهیم اطلاعات ریز 
)چهار هفته( را نمایش دهیم، جمع هزینه ماه خرداد را اصلا وارد نمی‏کنیم و فقط هزینه هر هفته را ثبت 

می‏نماییم.
ب��رای اینکه تنظی��م نماییم چند ردیف آخر مربوط به نمودار دایره‏ای زیرمجموعه می‏باش��د باید بعد از 

انتخاب نمودار و کلیک راست مسیر زیر را طی نمود. )شکل16-9(

 Format Data Series> Series Options> Second Plot Contains The Last
و در اینجا عدد 4 که نشان‏دهنده 4 هفته خرداد است را درج می‏کنیم. 

3. ف��رض نمایی��د می‏خواهیم میزان فروش در 3 س��ال مختلف را در ماه‏های فروردین و اردیبهش��ت و 
خرداد مقایسه نماییم. هدف از این مقایسه تنها مقایسه ماه‏های متناظر نمی‏باشد زیرا می‏خواهیم علاوه بر 
مقایس��ه هر ماه با ماه مش��ابه در سال دیگر از لحاظ کلی هم این سال‏ها با یکدیگر مقایسه گردند. بعبارتی 

شکل16-9
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میزان همپوش��انی هر سال با سال دیگر مشخص ش��ود. برای مثال بالا بهترین جواب را می‏توان از طریق 
نمودار Radar بدس��ت آورد. گوش��ه‏های ش��کل بوجود آمده، میزان فروش در هر ماه و مساحت هر شکل‏ 

نشان‏دهنده یک سال می‏باشد.
از روی شکل 10-16 می‏توان نتیجه گرفت هر سالی که مساحت بیشتر دارد وضعیت بهتری نسبت به 

سال‏های دیگر دارد در عین حال که هر ماه در کلیه سال‏ها با ماه‏های دیگر مقایسه می‏گردد.

4. در مباحث مالی و یا مدیریت پروژه مبحثی وجود دارد با نام جریان هزینه Cash Flow برای ترسیم 
این نمودار باید علاوه بر ستون اول که می‏تواند نام ماه‏های مختلف باشد باید دو ستون دیگر به نام هزینه 
هر ماه و هزینه تجمعی هر ماه را تش��کیل دهیم س��پس نمودار هزینه را میله‏ای و نمودار تجمعی هزینه را 
به صورت خطی ترس��یم نمود برای این کار در ابتدا نمودار را به صورت میله‏ای ترس��یم می‏نماییم سپس 
میله تجمعی را انتخاب و از منوی Design گزینه Change Chart Type را انتخاب و سپس نمودار خطی 

را بر روی این نمودار اعمال می‏کنیم. )شکل16-11(

شکل16-10
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5. نم��وداری جهت وضعیت دمای کوره در روزهای مختلف می‏خواهیم ترس��یم کنیم جهت این نمودار 
لازم است 3 ستون کمترین مقدار دما و بیشترین مقدار دما و میانگین دمای روزانه کوره ثبت گردد. این 

نمودار را با استفاده از نمودار نوع Stock باید رسم نمود.

نمودارهای پویا:
برخی مواقع بهتر اس��ت بجای رس��م نمودارهای متعدد، یک نمودار پویا رسم کنیم و موارد مختلف را از 
طریق یک نمودار نمایش دهیم. این کار از طریق نامگذاری محدوده‏ها و فرمول‏نویسی امکان‏پذیر می‏باشد، 
به عنوان مثال با انتخاب یک مورد از یک لیست یا تعیین تعداد آیتم‏های مورد نظر جهت نمایش، نمودار 

مربوطه برای ما ترسیم شود.
فرمولی که در ایجاد این تکنیک‏ها به ما کمک بس��یاری می‏کند، فرمول Offset می‏باش��د. همانطور که 
می‏دانی��د این فرمول پن��ج آرگومان دارد. دو آرگومان آخر این تابع در اینج��ا از اهمیت ویژه‏ای برخوردار 

می‏باشد.
در این قس��مت کاربرد نام‏گذاری محدوده‏ها در رس��م نمودار را بیان 

می‏کنیم.
فرض کنید می‏خواهیم نمودار ستونی را رسم کنیم که محورهای آن 
به ش��رح زیر است. محدوده‏ی A1:A7 را انتخاب و نام‏گذاری می‏کنیم. 
مثال� نام Mah. مح��دوده‏ی B1:B7 ه��م به همین ترتی��ب نام‏گذاری 

.Forosh می‏کنیم مثلا

برای رسم نمودار مراحل زیر را طی می‏کنیم:
1- ابت��دا بدون انتخاب محدوده، از مس��یر زیر اولی��ن نمودار به نام 
Clustered Column انتخ��اب می‏کنیم که چارچوب خالی نمودار ظاهر 

می‏شود.

شکل16-12

شکل16-13
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2- حال بعد از کلیک راست بر روی نمودار گزینه Select Data را انتخاب می‏کنیم. از جدول ظاهر شده، 
در قسمت Legend Enteries گزینه Add را می‏زنیم و به شکل زیر عمل می‏کنیم:

Insert> Charts> Column

3- ب��رای محورx ها هم از قس��مت Horizontal (Category) Axis Labels پس از زدن گزینه Edit به 
شکل زیر عمل می‏کنیم. )بجای درج آدرس محدوده، نام محدوده را درج می‏کنیم(

بنابراین مشاهده نمودید که برای رسم نمودار بجای آدرس‏ها چگونه از نام محدوده‏ها استفاده می‏کنیم. 
در مسئله بعد به توضیح ترسیم نمودارهای پویا می‏پردازیم:

فرض کنید در مثال قبل، می‏خواهیم تعداد ماه‏های مشخصی را نمایش دهیم. برای این کار ابتدا سلولی 
را جهت تعیین تعداد ماه‏های دلخواه مشخص می‏کنیم مثلا D1. حال از طریق فرمول Offset می‏خواهیم 
مح��دوده نم��ودار را متحرک کنیم. می‏دانیم که آرگومان چهارم این فرمول برای محدوده ما ارتفاع تعیین 

می‏کند. بنابراین:
=Offset(A2;0;0;D1;1)

این فرمول به این معنی اس��ت که از س��لول A2 به اندازه عدد موجود در سلول D1، پایین‏تر را انتخاب 
می‏کند و در حافظه خود نگه می‏دارد. مثلا اگر در سلول D1 نوشته‏ایم 4، این فرمول محدوده A2:A6  را 

در حافظه خود نگه می‏دارد.
حال این فرمول را نام‏گذاری می‏کنیم. برای انجام نام‏گذاری مراحل زیر را باید انجام دهیم:

Formula> Name Manager> New

شکل16-14
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فرمول مورد نظر را بصورت زیر وارد کنید:

با این کار محدوده محور Xها را نام‏گذاری می‏کنیم. 
برای Yها هم به همین روش عمل می‏کنیم و نام Forosh را برای فرمول زیر در نظر می‏گیریم:

=Offset(B2;0;0;D1;1)
برای رسم نمودار و تخصیص نام به نمودار مانند مثال قبل عمل می‏کنیم.

با تایپ عدد 2 در س��ل D1 فقط ماه‏های فروردین و اردیبهش��ت نش��ان داده می‏ش��وند. با تایپ عدد 3 
ماه‏های فروردین، اردیبهشت و خرداد نشان داده می‏شود.

شکل16-16

شکل16-17
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حال نمونه دیگری از این نمودارها را آموزش می‏دهیم:
فرض کنید بانک اطلاعاتی بزرگی داریم، که در آن اطلاعات فروش یک محصول در ماه‏ها و س��ال‏های 
مختلف موجود می‏باش��د. حال ما می‏خواهیم با انتخاب س��ال مورد نظر، نمودار فروش در ماه‏های مختلف 
را نش��ان دهیم. بانک اطلاعاتی ما به این ش��کل اس��ت که در هر سال فقط فروش برخی از ماه‏ها را داریم. 

بعبارتی تعداد میله‏ها در نمودار متغیر است. برای رسم این نمودار پویا مسیرهای زیر را طی می‏کنیم:
1- ابتدا اطلاعات هر سال را با استفاده از فرمول‏های جستجو (Vlookp) در یک کاربرگ دیگر، فراخوانی 

می‏کنیم.
2- ح��ال باید با اس��تفاده از فرمول Offset محدوده X و Y را تعری��ف کنیم. جدول اطلاعات بالا را در 
نظر بگیرید. فرض کنید که از بانک اطلاعاتی و توسط فرمول‏های جستجو فراخوانی شده است. )مثل بالا 
 Data Validation می‏توانیم س��ال را از یکی دیگر از ابزارهای فرم یعنی کمبوباکس یا لیس��ت فروریز در

انتخاب کنیم(
تعداد ماه‏ها در س��تون A مش��خص نمی‏باش��د، ب��ا انتخاب هر س��ال، این تعداد متغیر اس��ت، پس ما 
بای��د ای��ن تعداد را از یک فرمول اس��تخراج کنیم. فرمول Counta برای این کار مناس��ب می‏باش��د. مثلا 
Counta(A2:A13) چ��ون می‏دانیم بیش از 12 ماه نداریم. ) اما می‏توانیم در مواقع نیاز محدوده را خیلی 

Counta(A:A) بزرگتر انتخاب کنیم مثلا
حال از این فرمول در آرگومان چهارم فرمول Offset استفاده می‏کنیم. بصورت زیر:

=Offset(A2;0;0;Counta(A2:A13);1)

نکته: جهت زیبا و حرفه‏ای ش��دن هر چه بیش��تر، می‏توانید جهت تغییر عدد سلول D1 از ابزارهای 
ف��رم مانند Spin Button اس��تفاده نمایید ک��ه با کاهش یا افزایش اعداد ماه‏های مختلف را مش��اهده 

نمایید.
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بقیه مراحل را مانند مثال قبل ادامه می‏دهیم.
برای عنوان نمودار، همانطور که گفته ش��د می‏توانیم در یک س��لول، عبارت “میزان فروش  س��ال” را با 
سلولی که نشان‏دهنده سال انتخابی است، عطف کنیم. سپس باکس Chart Title را به سلی که این فرمول 
را در آن نوشته‏ایم متصل کنیم. با این روش با انتخاب هر سال، عنوان نمودار به همان سال تغییر می‏کند.

پس با اس��تفاده از ابزارهای فرم، ترکیب فرمول‏ها با یکدیگر و نام‏گذاری محدوده‏ها می‏توان نمودارهای 
پویا، تخصصی، زیبا و حرفه‏ای طراحی کرد. اینگونه نمودارها در جلسات، نرم‏افزارها برای ارائه گزارش‏های 

متنوع می‏توانند بسیار مفید می‏باشد.

Sparkline
 ,lineدر اکس��ل 2010 امکان رس��م نمودار در یک سل فراهم آمده است و به 3 صورت می‏باشد، نمودار

Win/Lose, Column. در ادامه هر یک را شرح می‏دهیم. 
 

Line نمودار
نم��ودار Line روند داده‏ها را در یک س��ل نمایش می‏دهد. مثلا در اینج��ا، برای هر نفر میزان فروش را 

نمایش می‏دهد. که چگونه افت و خیز داشته است.
از مسیر زیر نمودار Line را انتخاب می‏کنیم. جدول زیر ظاهر می‏شود. در Data Range محدوده داده‏ها 
را وارد می‏کنیم و در Location Range آدرس س��لولی که می‏خواهیم نمودار در آن رس��م گردد. ش��کل 

)19-16( بعد از زدن Ok نمودار مورد نظر رسم می شود. )شکل 16-20(

با کلیک بر روی سل حاوی نمودار، تب Sparklines Tools ظاهر می‏شود. 
در قسمت Edit Data محدوده اطلاعات را می‏توانیم تغییر دهیم.

در قسمت Type نوع نمودار را می‏توان تغییر داد. 
در قسمت Show گزینه‏های مختلفی وجود دارد که یک به یک شرح می‏دهیم:

High Point: ماکزیمم مطلق )بیشترین مقدار داده( را بر روی خط نمودار نشان می‏دهد.
Low Point: می‏نیمم مطلق )کمترین مقدار داده( را بر روی خط نمودار نشان می‏دهد.

شکل16-19
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Negative Point: مقادیر منفی را بر روی خط نمودار نشان می‏دهد.
First Point: اولین داده را بر روی خط نمودار مشخص می‏نماید.

Last Point: آخرین داده را بر روی خط نمودار مشخص می‏نماید.
Markers: این گزینه فقط برای نمودار Line فعال می‏باش��د و همه نقاط را بر روی خط نمودار نش��ان 

می‏دهد.
در قسمت Style هم تنظیمات مربوط به رنگ مورد نظر نمودار و رنگ نقاط روی نمودار می‏باشد.

و در آخر قسمت Group شامل تنظیمات زیر می‏باشد:
Axis )1: که می‏توانیم برای نمودارهای رسم شده محورهای مختصات رسم کنیم.

Group )2: اگر در یک س��ل نمودار رس��م کنیم و به سمت پایین درگ کنیم. برای سل‏های بعدی هم 
نمودار رسم می‏شود و بصورت خودکار با هم در یک گروه قرار می‏گیرند. هر تغییری بر یکی اعمال کنیم 
بر همه نمودارهایی که در گروه هستند اعمال می‏شود. مثلا اگر یکی را از Line به Column تغییر دهیم، 
همه نمودارها که در یک گروه قرار گرفته‏اند به Column تبدیل می‏شوند. در صورتی که بخواهیم نمودارها 

به هم مرتبط نباشند، از گزینه Ungroup استفاده می‏نماییم. 
 Group از طرفی می‏توانیم نمودارهای مختلفی که قبلا رس��م کرده‏ایم را انتخاب کنیم و با زدن گزینه

آن‏ها را در یک گروه قرار دهیم.
Clear )3: برای پاک کردن نمودارهای رس��م ش��ده نمی‏توان از Delete استفاده نمود. بلکه باید از این 

گزینه استفاده نمود.
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 Columnنمودار
این گزینه نمودار س��تونی برای داده‏های مورد نظر رس��م می‏کند و طول ستون‏ها بسته به مقدار داده‏ها 

متفاوت می‏باشد. 
روش رسم و سایر تنظیمات مشابه نمودار line می‏باشد که پیش‏تر توضیح داده شد.

Win / Lose نمودار
همانطور که از نام این نمودار پیداس��ت )برنده/بازنده( ، این نمودار، نموداری ش��بیه نمودار ستونی رسم 
می‏نماید. با این تفاوت که فقط تفاوت بین اعداد مثبت و منفی را مشخص می‏کند. طول ستون‏ها به مقدار 
داده‏ها بستگی ندارد. یعنی همه ستون‏ها طول یکسانی دارند. فقط داده‏های مثبت به سمت بالا و داده‏های 

منفی به سمت پایین رسم می‏شود.
روش رسم و تنظیمات این نمودار مانند نمودارهای قبل می‏باشد.
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مثال حل شده 

1- فرض کنید در دو رش��ته مهندسی و حسابداری اطلاعات زیر اخذ گردیده است. بهترین نوع نمودار 
برای این نوع داده‏ها به نظر شما چه می‏باشد؟ 

پاسخ: برای این داده‏ها نمودار دونات پیشنهاد بسیار خوبی است.
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